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This issue of Flowfront focuses on a new paradigm for implementing 
plastics simulation technology in today’s global enterprises.  
Enterprise-enabled simulation is about expanding the use of 

simulation technology beyond a single stage of product development.  
Moldflow is changing the way simulation technology is utilized to allow 
users at any stage of product development, from industrial design to 
process engineering, to access the technology, configure it to best 
meet their specific needs, easily integrate it into their work processes, 
communicate results among the entire design-to-production team, and 
take advantage of strategic, enterprise-wide implementation.

Enterprise-enabled simulation is about breaking traditional barriers to 
bring the benefits of simulation to a wider population, who will analyze 
a broader range of designs and perform those analyses not only to 
troubleshoot problems, but also to validate and, ideally, to optimize plastics 
part and mold designs at the earliest stages of product development.  
Read more about Moldflow’s vision of enterprise-enabled simulation in  
our cover story, beginning on page 18.

In this issue, we also present highlights of our most recent releases 
of Moldflow Plastics Insight® (MPI®) and Moldflow Plastics Advisers® 
(MPA®) products. New features and enhancements introduced in MPI 6.2 
and MPA 8.1 not only answer many user requests for improved usability 
and specific technology developments, but also support the enterprise-
enabled simulation paradigm.

We examine some customer successes in the context of innovative 
molding technologies and automotive industry-specific applications. Find 
out how Mack Molding Company (Arlington, VT) uses 3D simulation on a 
gas-assisted injection molding design to optimize part and tool design, 
material selection and choice of molding process to assure product 
manufacturability and durability. Read our automotive industry spotlight 
to see how companies including Jaguar and Promold are using Moldflow 
simulation to improve product quality, address environmental concerns, 
and stay competitive in a rapidly evolving industry.

You will also find useful tips and techniques to help you communicate 
analysis results more effectively. Learn how to create a script to automate 
export of MPI results for viewing in Moldflow Communicator, and take 
advantage of three specific tips to help you streamline report generation 
using both MPI and MPA software.

Dr. Robert Malloy, Professor and Chairman of the Plastics Engineering 
Department at the University of Massachusetts Lowell, offers his 
perspective on designing for recycling. Dr. Malloy is a well-respected 
researcher and consultant in the areas of plastics processing, design, 
and recycling of thermoplastics and the author of many publications and 
patents, including a textbook on plastic part design.

Throughout this issue, you’ll also see featured advertisements from 
our iMUG 2008 sponsors. This year’s International Moldflow User Group 
conference takes place on May 20-22 in Detroit, MI. 

Whatever role you fill in taking plastic parts from concept to 
manufacturing, you will find information here about Moldflow technology 
innovations, real-world applications, and business practices to help you 
optimize your product development process.

from the editor

Enterprise-Enabled 
Simulation
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Complete 64-bit solution:  �
In MPI 6.2 and MPA 8.1, both the 
graphical user interface (GUI) 
and the analysis solvers natively 
support 64-bit operating systems 
(in previous releases, the GUI was 
a 32-bit application running on 
a 64-bit operating system). This 
enables more efficient handling of 
large models and improves overall 
product performance on Windows 
x64-based platforms. 

Microsoft Windows Vista � ® 
support: Support for Windows 
Vista Business, Enterprise and 
Ultimate Editions is added in MPI 
6.2 and MPA 8.1.

Microsoft Office � ® 2007 
support: Project reports 
generated in Word and PowerPoint 

formats are compatible with 
Microsoft Office 2007 Edition. 

Configurable workspace  �
options: Task-specific user 
interface configurations can 
be saved and shared among 
various stakeholders across the 
enterprise. 

Product consistency  �
enhancements: MPI 6.2 and MPA 
8.1 introduce terminology changes 
which have been implemented to 
improve consistency within each 
product and across all Moldflow 
products. Within each product, 
these changes reduce differences 
between online Help topics and 
what is displayed in the user 
interface, and also unify terms 
used to refer to similar features 

of the Dual Domain™ and 3D 
analysis technologies. Across 
Moldflow products, these changes 
reduce product-specific differences 
in terms referring to similar 
analysis technologies, analysis 
sequences and results.

Moldflow Communicator  �
compatibility: MPI 6.2 and 
MPA 8.1 Revision 3 support 
export of Moldflow Results 
(*.mfr) files that can be viewed 
in Moldflow Communicator 2.0. 
Moldflow Communicator is a 
free utility developed specifically 
for visualizing, quantifying and 
comparing Moldflow Results files. 
 
Details of product-specific changes are 
described on the following pages.

what's new

Latest Releases 
of Moldflow Design Analysis Software Support  
Enterprise-Enabled Vision

By Hanno van Raalte, PRoduct line ManageR, and MuRali annaReddy, diRectoR of PRoduct MaRketing

CAD Connectivity 
Tools

Structural CAE 
Interfaces

API

MPI & MPA Reports

Moldflow
Communicator

Training Services

Technical Support

Plastics Labs

MPA

MPI

MPI-e

Enterprise-Enabled Simulation

Changes common to both MPI 6.2 and MPA 8.1 include these:

The latest releases of Moldflow Plastics Insight® (MPI®) and Moldflow Plastics Advisers® 
(MPA®) products support the company’s vision of enterprise-enabled simulation to optimize 
plastic product development processes. 
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Moldflow Plastics Insight (MPI) 
6.2 introduces significant user 
interface enhancements and 
several new solver technologies to 
respond to customer requests and 
increase user productivity. 

User Interface 
Enhancements
Synergy Graphical User 
Interface Updated 

The Synergy GUI has undergone 
a significant facelift in the MPI 
6.2 release, with newly designed 
icons and a new background, 
terminology changes, and new 
commands. These changes follow 
similar changes implemented in 
MPA to enhance compatibility 
across product lines.

In particular, new icons used 
to indicate analysis status elimi-
nate English language-dependent 
symbols used previously, making 
product localization more straight-
forward and enhancing usability in 
the global community.

Terminology changes have 
been implemented to create 
more consistency between the 
MPI GUI and Help system and 
among all Moldflow products. The 
most notable changes are made 

to analysis sequence names (for 
instance, Fill+Pack replaces Flow 
in the list of available analysis 
sequences for most molding 
processes), result names, and 
analysis technology (Dual Domain 
technology is referenced instead of 
using the Fusion product name).

New commands include a Close 
All Documents command available 
from the Window menu, as well 
as a new results Scaling toolbar 
available from the View menu, 
which allows dynamic adjustment 
of the minimum and maximum 
scale of the displayed result.

 
Configurable Workspace 
Options

MPI 6.2 introduces a Workspace 
tool, a key feature aimed at 
improving user productivity as well 
as reducing product complexity to 
broaden the use of MPI throughout 
the entire enterprise. 

On a typical project, a majority 
of the user’s time is spent in 
interacting with the user interface. 
A customized user interface that 
conforms to an optimal workflow 
for specific tasks has great potential 
to improve user productivity. MPI, 
with its ever-increasing product 
breadth, can pose daunting training 

and usability challenges, especially 
to novice users. 

People in different roles in the 
product development process 
all would use MPI differently. 
For example, an industrial 
designer might want to perform 
a manufacturing feasibility study, 
a plastics engineer might want 
to evaluate material selection 
options, a structural engineer 
might be interested in analysis 
results such as weld line locations, 
fiber orientation and predicted 
displacement, while a molder 
might focus on machine selection 
and process setup parameters. The 
Workspace tool allows the user 
interface to be customized to fit 
a user’s job function, knowledge, 
skill set and experience.

The following aspects of MPI 
can be customized and saved to a 
workspace file:

Molding processes  �

Analysis sequences  �

Mesh types  �

Databases (Thermoplastic/ �

Thermoset materials, Coolants, 
Mold materials, and Molding 
machines) 

Analysis results  �

Menu toolbars  �

what's new

Moldflow 
Plastics Insight 6.2
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Meshing options  �

Several preconfigured work-
space files are distributed with MPI 
6.2 (identified as Moldflow work-
spaces). Besides these, you can 
set up personal (User) or shared 
(Company) workspaces. 

New Interfaces with 
Development Partners

Export to Altair ➠ ® Engineering’s 
H3D Data Format 

MPI 6.2 offers the capability 
to export the meshed model and 
results to Altair Engineering's H3D 
data format. Through this option, 
the MPI model and results can 
be visualized in Altair HyperView 
9.0 and other Altair products that 
support the H3D format. 

Interface to Code V ➠ ® Optical 
Design Software 

MPI 6.2 features an interface 
to CODE V, optical design software 
from Optical Research Associates®. 
Through this interface, it is possible 
to export the optical properties 
predicted by a Birefringence 
analysis and use this information 
to investigate how the molding 
process affects the optical 
properties of lenses. 

MPI Enterprise Edition 
Enhancement Offers 
Increased Accessibility

For users of the MPI Enterprise 
Edition (MPI-e), new in MPI 6.2 is 
the ability to install the Moldflow 
Plastics Advisers (MPA) software 

and access its suite of products 
using MPI-e tasks. 

MPI-e users can leverage this 
increased accessibility to MPA and 
MPI products to allow more users 
throughout the enterprise to real-
ize the benefits of injection mold-
ing simulation. In particular, part 
and mold designers as well as nov-
ice simulation users now can take 
advantage of MPA’s guided user in-
terface, model-specific design ad-
vice, and wizard-driven runner and 
cooling channel modeling tools.

  

Solver Technology  
Enhancements
3D Flow Solver Speed 
Improvements

The Coupled 3D Flow solver 
offers a new AMG matrix solver 
option, and the code has undergone 
rigorous review and optimization 
to perform more efficiently. The 
average 3D Fill+Pack analysis 
sequence using the Coupled 3D 
Flow solver now runs in less than 
half the time required to perform the 
same analysis in MPI 6.1, without 
affecting the analysis results.

New AMG Matrix Solver Option  ➠
for Coupled 3D Flow Solver

An optional AMG solution method 
is available for 3D Fill+Pack analysis 
sequences using the Coupled 3D 
Flow solver. When this option is 
enabled, the average expected 
analysis time speed-up factor is 2.0 
or more (where the speed-up factor 
is defined as the ratio of analysis 
time in MPI 6.1 to the analysis time 

in MPI 6.2). The speed-up factor is 
model-dependent. 

By default, the AMG matrix 
solver selection option is set 
to Automatic. This setting allows 
the 3D Flow solver to examine the 
model and determine whether or 
not the AMG matrix solution is ad-
vantageous. Various parameters in-
fluence the outcome of this setting, 
including the model size (number 
of elements in the mesh), the op-
erating system, and the selected 
analysis sequence and analysis pa-
rameters. 

The AMG matrix solver does not 
provide a clear advantage for small 
models (fewer than 200,000 tetra-
hedral elements). The AMG matrix 
solver also uses more memory (up 
to 50% more). As a result of these 
two factors, on a 32-bit operating 
system, the AMG matrix solver will 
not be used when the solver selec-
tion option is set to Automatic.

Coupled 3D Flow Solver  ➠
Optimization

An additional average speed-
up of 30% is achieved through 
code optimization and algorithmic 
improvements. The speed 
improvement depends upon 
several factors; key among these 
are the model size, selected 
molding process, selected analysis 
sequence (Fill or Fill+Pack), and 
the hardware configuration. 

New Advanced Gate Locator 

MPI 6.2 introduces a new 
Advanced Gate Locator algorithm for 

what's new

1. Moldflow Mold Designer Workspace    2. Moldflow Optical Workspace



www.flowfront.com 11Flowfront | May 2008

Midplane, Dual Domain, and 3D 
meshes, which can help with 
making important gating decisions. 
The Advanced Gate Locator offers 
significant improvement over the 
previous gate location algorithm 
with two new capabilities:

Simultaneously search for  �

and recommend up to 10 gate 
locations.

Account for specific regions  �

of the part geometry that have 
been prohibited from gating 
considerations.  

The Advanced Gate Locator 
aims to identify gate locations that 
will produce the lowest injection 
pressure. Regions that should 
not be used for gating because 
of aesthetic, tooling or other 
reasons, can be excluded before 
starting the analysis by selecting 
specific nodes on the model that 
are designated as prohibited gate 
nodes. The Advanced Gate Locator 
will not consider prohibited nodes 
in searching for recommended gate 
locations. 

A Gate Location analysis 
sequence in MPI 6.2 uses the new 
Advanced Gate Locator algorithm 
by default. The previous gate 
location analysis algorithm has 
been renamed to Gate Region 
Locator. 

Expanded Scope of 3D Warp 
Analysis 

3D Warp Analysis Handles More  ➠
Overmolding Configurations

Complex overmolded parts may 
have numerous configurations in 
which the various components are 
positioned. Previously, only a limited 
subset of these configurations could 
be properly simulated for warpage 

continued on page 12

MPA 8.1 delivers new 
technologies and key enhancements 
to help users analyze a broader 
range of parts with Advanced 3D 
technology, improve productivity 
with a redesigned user interface, 
shorten analysis preparation 
time with powerful and flexible 
modeling tools, interpret results 
more efficiently using new results 
visualization options, and increase 
collaboration with expanded 
communication capabilities.

Extended Solution 
with Advanced 3D 
Technology 

Advanced 3D analysis 
technology provides the ability 
to analyze accurately part (mold 
cavity) designs that have thick 
regions or abrupt changes in 
thickness. Geometry features such 
as these are not suitable for MPA's 
Standard Dual Domain analysis 
technology, which has been 
developed and fine-tuned for the 
thin-walled part geometry that is 

most often encountered in plastic 
injection molding applications. 
The Advanced 3D analysis option 
dramatically increases the number 
of designs that can be successfully 
analyzed using MPA software.The 
Advanced 3D analysis also works 
with the Performance Adviser and 
Cooling Circuit Adviser add-on 
modules to evaluate part warpage 
and account for the effects of the 
cooling system, respectively.

continued on page 13

what's new

The new Advanced Gate Location analysis 
can simultaneously search for up to 10 gate 
locations and allows specified areas of the 
part to be prohibited from the analysis. 

Moldflow 
Plastics Advisers 8.1

Advanced 3D analysis option handles 
designs that have thick regions or abrupt 
changes in thickness.
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using 3D meshes. An improved  
algorithm in 3D Warp now 
establishes contacts between all 
components in single-shot and 
2-shot overmolding applications, 
including part inserts. 

The improved algorithm also is 
better able to tolerate small gaps 
between the meshes on different 
overmolding components. This 
is particularly important when 
working with components that have 
curved contact surfaces between 
them, where it can be challenging 
to ensure perfect contact between 
the meshes. 

3D Warp Analysis for Gas- ➠
assisted Injection Molding 
Applications

Product designers can now 
evaluate the effect of hollowed-out 
gas channels on the overall part 
deflection. The 3D Warp analysis 
can be run in parallel on a multi-
processor system. The Isolate 
cause of warpage option is also 
available, which can help to identify 
the source of warpage. 

Exclude 3D Cold Runner  ➠
Elements from Analysis 

MPI 6.2 now offers the ability to 
assign a new Cold runner (3D) 
element property to tetrahedral 
elements. This allows the 3D Warp 
solver to identify which elements 
belong to the part and which to 
the cold runner system and to 
exclude the cold runners from the 
warpage analysis. This improves 
the accuracy of the part warpage 
predictions and reduces the analysis 
time. The new element property 
does not change the Coupled 3D 
Flow or Cool solvers.

Other Enhancements

New Micro-mechanics Model  ➠

A new micro-mechanics model, 
the Mori-Tanaka model, has been 
implemented to provide more 
accurate shrinkage and warpage 
predictions of fiber-filled liquid 
crystalline polymer (LCP) materials. 
The Mori-Tanaka micro mechanics 

model is much better able to 
capture the anisotropic nature of 
LCPs, and this significantly improves 
the calculation of mechanical 
properties for this special class of 
materials, which are often used in 
the connector industry. 

The Mori-Tanaka model can be 
used with Midplane, Dual Domain 
and 3D analysis technologies. The 
model is used automatically if the 
selected material contains the 
appropriate material properties 
data.

Simulate Rapid Heating and  ➠
Cooling Processes

In the conventional injection 
molding process, the mold is 
maintained at a near-constant 
temperature throughout the 
molding cycle. However, newer 
molding techniques have been 
developed which use a variable 
mold temperature. The mold is 
maintained at a hotter temperature 
during the filling phase to facilitate 
filling and achieve smooth surface 
appearance. During the packing 
and cooling phases, the mold 
is switched to a much cooler 
temperature to assist in freezing 
the part and decrease the cycle 
time. 

MPI 6.2 allows variable mold 
surface temperature profiles to 
be set up for use in Fill and Pack 
analyses. Variable temperature 
profiles can be specified on 
all element types (cavity, cold 
runners, cold sprue, cold gates 
and part beam) except hot runner 
elements. 

Venting Analysis for 3D  ➠
Reactive Molding and Microchip 
Encapsulation Processes

Because the injection 
pressures are often very low in 
reactive injection and microchip 
encapsulation molding processes, 
the build-up of air pressure in the 
unfilled cavity due to inadequate 
venting can influence the material 
flow during filling. 

MPI 6.2 offers the capability to 
specify venting analysis locations 

and vent sizes, which are then 
considered in the flow analysis 
when the option to perform venting 
analysis is enabled. The venting 
analysis calculates the air pressure 
build-up in the unfilled cavity, based 
on the venting locations and sizes, 
and accounts for the influence 
of the air pressure on the filling 
pattern. This feature is supported 
for 3D Reactive Molding and 3D 
Microchip Encapsulation molding 
processes only. 

User-specified Gate Size for 3D  ➠
Meshes 

The new Gate contact diam-
eter setting allows the gate size 
to be specified at a single injection 
point on 3D meshes that do not 
have a runner system and gate(s) 
explicitly modeled. 

New Annular Beam Element  ➠
Formulation 

A new formulation to represent 
annular hot runners explicitly 
improves analysis accuracy using 
Midplane and Dual Domain analysis 
technologies. 

Pack and Warp Analysis of  ➠
Thermoset Materials Extended to 
All Mesh Types 

In MPI 6.2, it is now possible 
to simulate the packing, shrinkage 
and warpage characteristics of 
thermoset materials for Reactive 
Molding and Microchip Encapsulation 
processes using Midplane and Dual 
Domain analysis technologies. ■

Moldflow Plastics insight 6.2│ continued

what's new
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what's new

Focus on Productivity 
and Ease-of-use 

MPA 8.1 features a panel-
based user interface that has been 
designed to streamline project 
management tasks, improve 
access to analysis results and 
supplemental information, and 
enhance user productivity, while 
maintaining the familiar, guided 
workflow established in previous 
MPA releases.

Configurable Workspace 
Options 

Show or hide panels and toolbars 
to customize the workspace 
configuration for a specific 
workflow. For example, create 
one workspace to support tasks 
prior to running an analysis and 
a second workspace for reviewing 
and comparing results. 

Save the customized workspace 
to a file for later reuse or sharing 
with other MPA users across the 
enterprise. 

MPA provides two pre-configured 
workspaces and remembers the 
last-used workspace configuration 
when you reopen the software. 
You can easily switch from one 
workspace configuration to another 
at any time.

Powerful and Flexible 
Modeling Tools

Runner and cooling channel 
layouts can be quickly and easily 
imported from CAD systems or 
created using new modeling planes, 
snap tools, and visual cues to aid in 
precise positioning.

New �  Runner System Wizard 
produces a complete feed 
system automatically based on 
user-specified sprue, runner and 
gate properties. 

Modeling planes feature aids  �

in quick and easy creation of 
runner and cooling channel 
segments. 

Visual cues are offered when  �

modeling runner segments to 
assist in their creation. 

Export optimized runner and  �

cooling channel layouts for reuse 
in a CAD system.  

Intuitive Results 
Interpretation

New results visualization options 
allow for the comparison of results 
from multiple analysis iterations to 
realize design improvements and 
better understand plastics material 
behavior. New Dynamic Help 
functionality allows users to quickly 
understand those results that have 
the greatest impact on optimizing 
their part and mold designs. 

 

Increased 
Collaboration

Enhanced report generation 
capabilities make it possible to 
automatically generate reports in 
Microsoft® Word® or PowerPoint® 

formats in addition to web-ready 
HTML format, to easily communicate 
valuable analysis results across the 
enterprise. 

Smart Tools
MPA 8.1 features a redesigned 

Cost Adviser that facilitates 
detailed part cost analysis. 
Association with the model allows 
evaluation of how changes to part 
design, mold design, material 
choice, and processing conditions 
affect part cost. After the Cost 
Adviser is set up for a given 
project, it will track the changes to 
the model, material and processing 
conditions automatically and 
display the current cost based on 
material usage, cycle times, post-
molding costs, operating costs and 
overheads. ■
For more information about MPA 8.1 
and MPI 6.2, contact your local Moldflow 
representative or visit www.moldflow.com. 

The panel-based user in-
terface design streamlines 
workflow, provides unin-
terrupted access to the 
model, and improves over-
all user productivity.

Easily create project reports in Micro-
soft Word or PowerPoint formats.

Moldflow Plastics Advisers 8.1│ continued
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From a consumer standpoint there has been 
a definite shift in purchasing considerations 
over the last two years. Concerns about safety 

and serviceability have gone down while interest 
in environmental friendliness and alternative fuel 
sources has risen significantly.  

Now, more than ever, major automakers and 
their suppliers are harnessing Moldflow simulation to 
improve their product quality, make their products 
more environmentally friendly, and stay competitive 
in their market.  

Product Quality
For over 75 years Jaguar, based in Coventry, 

England, has manufactured vehicles that deliver a 
unique blend of style, luxury, and performance. As a 
premium car maker, they consider product quality to 
be paramount. According to a review in New London, 
Connecticut’s The Day newspaper, "Jaguar´s quality 
is ranked above that of its European rivals, Mercedes-
Benz, BMW and Audi.” With world-class engineering 
talent and advanced design and optimization tools, 
Jaguar continues its rich and distinguished heritage 
of innovative automotive manufacturing.

One challenge Jaguar has had to surmount is due 
to the increasing number of plastic parts being used in 
interior, exterior, and under-hood applications. Until 
recently, the company had been leaving analysis of 
their plastic parts to their suppliers and had not been 
performing up-front work in-house to optimize their 
designs for manufacturability. This often resulted in 
late design changes, costly rework, and the risk of 
entire programs being late for crucial milestones.

On a center console finisher for their new Jaguar 
XF interior, they identified multiple problems in the 
parts coming from the original mold design. Air traps, 
poor fiber orientation, sink marks, and unacceptable 
warpage resulted in a 42% scrap rate at an estimated 
cost of $1 million in scrap and rework.

In an effort to address these issues as early as 
possible in the product development cycle, Jaguar 
invested in Moldflow Plastics Insight® (MPI®) software 
to test three different changes to the thickness in 
the center of the part where filling hesitation was 
occurring. On the third iteration, they found the 
optimum wall thickness that produced a uniform 
filling pattern, appropriate fiber orientation, and 
minimal volumetric shrinkage. This design iteration 

real world success

Even with all the current instability in the 
automotive industry, executives are still 
reporting the major issues they face have 
not changed much in the past few years. 
According to KPMG’s 2008 Global Auto 
Executive Survey, product quality, cost 
reductions, harnessing new technolo-
gies, and global competition are the ma-
jor challenges, with environmental issues 
becoming more notable.                                         
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also removed the weld lines entirely and pushed the 
air traps to the edge of the component.

Once the proper wall thickness was found for 
the part design itself, the engineers used MPI to 
optimize the processing parameters and cooling 
system to minimize the amount of warpage that 
occurred in the molded part. After several iterations, 
the displacement in a critical area was reduced from 
12.8 mm to 1.2 mm. In production, this resulted in a 
13% decrease in the scrap rate due to warpage.

After the optimization, the total scrap rate was 
reduced from 42% to 7%, with most of the remaining 
scrap due to the veneer in-mold decoration.  The 
cost savings on this project alone due to the reduced 
amount of scrap and improved production efficiency 
is estimated at over $1.1 million.

In total, 181 new plastic component designs 
were validated and optimized for the new Jaguar XF 
sport sedan using MPI software. With the successful 
implementation of MPI, Jaguar is now able to fully 
control the part and mold and ensure the designs 
of each are fully optimized. Their dependency on 
suppliers to get it right has been minimized along 
with the number of late design changes, the amount 
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of rework, and the risk of programs missing their set 
milestones.

Environmental Friendliness
Over the past twenty years, automakers have 

made evolutionary gains in fuel efficiency from 
improvements and innovations in powertrain design. 
However, these improvements have been countered 
by increases in vehicle weight because of the use of 
higher strength steels and other heavy safety features 
such as airbags. For example, a 2008 Chevrolet Cobalt 
with significant improvements in engine efficiency 
still gets the same mileage as a similar 1988 model, 
because the Cobalt weighs 17% more.

To address environmental concerns, many auto-
motive component manufacturers now  are  focusing 
on finding ways to reduce carbon dioxide emissions by 
optimizing their plastic part designs to reduce mass 
while still maintaining product performance and qual-
ity. This strategy not only helps improve fuel economy 
of the vehicles in which their parts are installed, but 
it also reduces the consumption of raw materials, the 

energy needed for manufacturing, and the need for 
replacement parts. 

Promold, an engineering consultancy firm based 
in Paris, France, offers MPI analysis services to their 
customers.  Promold was contracted by Valeo, a 
major supplier of automotive components to well-
known vehicle manufacturers, to optimize the design 
of a new headlamp housing for a Renault sedan. The 
initial design weighed 244 grams with a wall thickness 
of 2.15 mm. The constraints for manufacturing were 
that the parts must be produced on an 800-metric-ton 
molding machine and there could be no weld lines in 
the vicinity of where the primary headlamp bulb would 
be installed.

Promold used MPI software to virtually experiment 
with three material options (polycarbonate, nylon, 
and PBT), five different part thicknesses ranging 
from 2.15mm to 0.8mm, and six different gating 
configurations. The experiment was set up to use the 
full capacity of the designated molding machine’s 174 
MPa maximum injection pressure so the wall thickness 
could be reduced as much as possible. The first step 
was to evaluate the three materials based on their 

real world success
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“Product development is now commodity, 
you must introduce product optimization and 
a real time ‘analytical vision’, if not, your 
competitors will...”

flow characteristics to minimize the pressure required 
to fill the part. Next, the wall thickness and number 
of gates were optimized simultaneously to ensure the 
parts did not exceed the injection pressure limit of 
the machine and no weld lines were created in critical 
areas.

The experiment resulted in the selection of the 
PBT material for a design with a wall thickness of only 
1.2 mm that used a 5-gate hot-runner system. The 
final weight of the part was 41% less than the original 
design and took advantage of the full capability of 
the molding machine used. Performance and quality 
criteria were also met, with no weld lines in any critical 
areas of the part and no sacrifices in strength due to 
the thinner walls.

Obviously, saving 100 grams in the weight of a 
headlamp housing is not going to have a significant 
effect by itself on the fuel economy of a vehicle.  
However, with plastics approaching 10% of the average 
total vehicle weight, incorporating these methods 
into the best practices of an organization will ensure 
that all new products developed will be optimized for 
mass, and taken together, they can have a sizable 
impact on a vehicle’s fuel efficiency. Also, less material 
consumed and reduced amounts of energy required 
during production present opportunities for cost 
savings in conjunction with improved environmental 
friendliness.

Going Forward
Executives and directors in all major automotive 

companies have recognized the importance of using 
simulation to stimulate innovation and to get products 
to market as fast as possible. Those that have 
implemented Moldflow injection molding simulation 
software have seen great success in improving product 
quality and increasing environmental friendliness of 
their plastic products, as the examples described here 
have shown.

Carlos Ghosn, CEO of Renault and Nissan, is largely 
credited with the complete turnaround of Nissan since 
2005. Ghosn outlines a strategy of, “…using less and 
less prototypes, more digital simulation to decrease 
time-to-market,” in his company’s 2009 Strategic 
Plan. 

“Product development is now commodity, you 
must introduce product optimization and a real time 
‘analytical vision’, if not, your competitors will,” notes 

John L. Sullivan, Ford’s Director of Process, Methods, 
Tools, and Information at a recent CAE conference.

Going forward, companies in the automotive 
industry, in particular, can benefit from using simulation 
throughout development to optimize every plastic 
product they produce. The greatest potential benefits 
come from moving beyond using simulation just to 
discover and avoid potential problems and instead 
using simulation to truly optimization designs to 
address criteria that have been identified as mission-
critical to their businesses.

Moldflow’s vision of enterprise-enabled simulation 
(see cover story on page 18) supports the immediate 
needs of the automotive industry by providing a 
methodology that enables everyone involved in new 
product development, from industrial designers to 
process engineers, the ability to perform analyses 
and improve the design early and often. This type of 
implementation allows for the designs to be tailored 
to whatever the best practices of the organization 
dictate, whether it be product quality, environmental 
friendliness, time-to-market, or any trend currently 
shaping the industry. ■
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Enterprise-enabled simulation is 
a methodology for implementing 
analysis software into the best 
practices of any organization that 
designs and develops new products. 

At its core, enterprise-
enabled simulation is 
focused on empowering 

everyone involved in new product 
development to confidently 
analyze  their own designs and 
use the results to optimize parts 
for both manufacturability and 
performance.

Organizations involved in 
the design and manufacture of 
plastic parts are facing continuous 
pressure to get innovative products 
to market faster than ever. These 
compressed development cycles 
often result in simulation only being 
used to troubleshoot or validate 
part and mold designs in the latter 
stages of development. Failure to 
perform simulation early not only 
results in a greater likelihood of 
defective parts, but also in lost 
opportunities to optimize the 
product for both manufacturability 
and performance.

The question now being posed 
by these organizations is, “How do 
we incorporate simulation into our 
best practices so designs can be 
optimized using analysis results?” 

 

A Brief History of 
Simulation Use

Thousands of companies around 
the world currently employ simu-
lation to some extent, and many 
view it as a competitive differentia-
tor.  Over the course of three de-
cades, the manner in which these 
businesses use simulation has 
evolved as the accuracy and speed 
of the software improved and as 
they looked for new ways to out-
pace their competitors.

Using Simulation as a 
Troubleshooting Tool

When simulation tools first 
gained widespread use, it was 
typically to fix a problem discovered 
in production environments or even 
in end-use applications. A single 
analyst would then troubleshoot the 
problem and determine a solution 
given the existing constraints. Of 
course, even if the analyst was 
successful, valuable time and 
material had already been wasted, 
driving up costs.

Enterprise-Enabled 
Simulation

By BRian SatHeR, tecHnical MaRketing SPecialiSt
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Using Simulation as a 
Validation Tool

As simulation tools and 
computers grew faster, the next 
logical step was to validate part or 
mold designs prior to committing 
to the mold build. Any errors in the 
designs could be communicated 
by the simulation expert to the 
engineer responsible, and the issue 
could be fixed prior to steel ever 
being cut. 

While this results in more 
value being realized from the use 
of simulation, there is still the 
potential for significant hidden 
costs because parts and molds are 
not being optimized. For example, 
without optimization, companies 
are not determining if a part could 
be made thinner, which would 
reduce material usage, decrease 
cycle times, use less energy, and 
lower overall costs.

The problem with using 
simulation to troubleshoot existing 
problems or validate designs is that 
both of these approaches focus 
on problem-fixing and problem-
avoidance, rather than on trying to 
create truly optimized designs.

Current Trends in 
Simulation

Global competition, concerns 
about the environmental impact of 
new products, and shortened time 
to market are the critical pressures 
that businesses designing and 
manufacturing plastic parts 
are currently facing. From an 
engineering standpoint, these 
pressures translate into the need 
to optimize product designs so 
each part is manufactured at the 
lowest cost, with the least amount 
of material, and in the shortest 
development cycle possible.

Simulation Driven Design

Industry leaders are responding 
to these pressures by implement-
ing simulation earlier in the devel-
opment stages to actually drive 
the design of the part. Using this 
method, designs are analyzed and 

improved iteratively so potential 
problems are solved preemptively 
and products are optimized prior to 
starting production. This method 
has proven to be extremely effec-
tive because  quality is now de-
signed into the product and less 
testing is required in the later 
stages, which improves the overall 
efficiency of new product develop-
ment.

Paul Hornikx, Mechanical 
Engineer in Microsoft’s hardware 
division, speaks of the problems 
with not utilizing simulation early: 
“Being late, and not knowing about 
it until the end, is very costly. 
Airship, losing shelf space, flying 
engineers all over the place, lost 
engineering time for the next 
programs, and the stress on the 
engineering group is phenomenal.” 
He adds, “This should all be 
incentive to do analysis as early as 
possible.”

Hornikx utilizes simulation 
early in product development, 
performing analyses on industrial 
design concepts prior to adding 
the internal engineering features. 
Recently, during the design of a 
bottom case for a new keyboard, 
he found that a thick section 
around the perimeter of the part 
would have created a tension ring 
that would cause the part to warp 
significantly. 

Using the simulation results, 
Hornikx went back to industrial 
design with two options: move the 
parting line or reduce the thickness 
of the sidewalls. He was able to 
negotiate a 1.5 mm reduction 
in the thickness, which instantly 
removed a majority of the warpage 
from the part.

Challenges in 
Achieving Widespread 
Simulation Use

An inherent problem with 
plastics product development is that 
people involved in the early stages 
of design have the most influence 
on manufacturability, but it is the 
production engineers at the end of 
development who are responsible 
for optimizing the process. Pushing 

simulation into the earlier stages 
of design counters this effect but 
presents its own challenges due to 
time constraints, lack of expertise, 
and also because of the current 
way simulation software is priced 
and sold.

No Time for Simulation

Without question, running 
multiple analyses at each phase 
in the design of a new product 
will increase the quality and 
manufacturability of the part. The 
problem is that each analysis can 
take anywhere from a few minutes 
to several hours to complete, 
due to model preparation, actual 
processing time, and results 
interpretation. With already 
compressed development cycles, 
the amount of time available to run 
these analyses is very limited.

The challenge is to make 
simulation as lean as possible for 
each type of user, thus reducing 
the amount of “waste” in the form 
of superfluous results and extended 
analysis times.

Simulation: “Experts 
Only” Please

Typically, the use of injection 
molding simulation is isolated to 
only a few engineers within an 
organization whose primary job 
function is running analyses for the 
rest of the development group. This 
has been the case for two reasons: 
the intricacy of the injection molding 
process and the complexity of the 
simulation application.

Crafting a successful injection 
molding process requires a thorough 
understanding of the multitude of 

Part
Design

Mold
Design

ProductionIndustrial
Design

Mold
Build

Responsibility

Influence



cover story

20 Flowfront | May 2008 www.flowfront.com

variables that must be skillfully 
manipulated to get an acceptable 
part.  While the latest processing 
methodologies and technologies 
have turned injection molding from 
an art form to a science, anyone 
new to the process would be 
overwhelmed with the amount of 
options available. 

Due to all these variables, and 
also because of the many variants 
of the injection molding process 
itself, even the most carefully 
designed simulation application has 
an intimidating amount of features 
to navigate. The leading simulation 
products currently offer multiple 
meshing options, thousands of 
material choices, support for 
several different molding processes, 
and options for viewing shrinkage, 
warpage, and other potential part 
defects. While all these tools are 
required by the expert user, having 
this many options dissuades people 
who are unfamiliar with simulation 
from using the product.

The question going forward is, 
“How does one simulation package 
accommodate people with little 
simulation experience while still 
maintaining the functionality the 
expert user demands?”

The Pricing Model for 
Simulation

The way simulation is priced 
and sold has always been based on 

the presumption that organizations 
allocate simulation to only a few 
dedicated users. While the cost is 
certainly justified when considering 
the savings dedicated users provide, 
there are very few companies 
that are able to purchase a copy 
for every occasional user in new 
product development. 

Because designers will never 
be full-time simulation users, they 
only need access to the simulation 
software when they are ready to 
run an analysis on their current 
design iteration. This type of use is 
not efficient with the way simulation 
is currently licensed, because a 
majority of the time the designer is 
designing, not analyzing. 

What is needed is a system 
where all licenses purchased are 
being used as much as possible 
by as many people as possible to 
maximize the value of simulation.

The Solution: 
Enterprise-Enabled 
Simulation

To overcome the challenges of 
time constraints, lack of expertise, 
and the way simulation is priced 
and sold, businesses are turning 
to enterprise-enabled simulation 
to optimize their new products and 
development cycles. 

Fortunately, new enterprise-
enabled simulation solutions have 
been created that give everyone 
involved in development the tools 

they need to analyze their piece of 
the design and use the results to 
optimize their work.

A shared licensing system 
is used in enterprise-enabled 
simulation, where every seat 
purchased is placed into a pool 
where it becomes accessible to 
anyone involved in new product 
development. For occasional users, 
this means they have the ability to 
access the software whenever they 
need it without requiring their own 
individual license. Because each 
user does not need a dedicated 
license, businesses can assess 
what their simulation needs are and 
determine the optimum number to 
purchase so each license is used 
efficiently. This is also the ideal 
system for growing companies, 
because it is easily scalable by 
simply adding more licenses as 
simulation use becomes more 
common or more users are added.

Enterprise-enabled simulation 
can be customized to a specific job 
function and the types of analyses 
and results required at a particular 
stage of development. For example, 
industrial designers may only 
require a simple filling analysis, 
whereas mold designers need to 
be able simulate filling, cooling, 
warpage, shrinkage, and so on. 
The software can be configured at 
every level, from meshing options 
to the selection of the material, 
available processing methods, and 
default results displayed. 

The key to integrating simulation 
into new product development is 
to ensure everyone is comfortable 
using the software and confident 
in their results. The enterprise-
enabled simulation methodology 
includes training programs 
specifically designed for different 
user levels, technical support for 
help with tackling the tough issues, 
and many other critical support 
features to ensure simulation 
becomes part of the company’s 
best practices. 

Enterprise-enabled simulation 
is about more than just the 
application; it is also about a 
technology partnership with the
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The Benefits  
of Enterprise-Enabled 
Simulation

Some of the specific benefits that can be realized 
through the use of enterprise-enabled simulation 
include these: 

Faster time-to-market: As more users learn 
about and benefit from the value of simulation, devel-
opment cycles will inherently move faster, allowing com-
panies to outpace their competitors at every turn.

Empowered engineers: Designers throughout 
the development cycle now have the capability to im-
prove upon their design using results from their own 
analysis.

Reduced product costs: Optimized designs mean 
shorter cycle times, lower part weights, and less scrap, 
which all result in huge returns for the organization.

Improved part quality: Parts with designed-in 
quality will cost less to manufacture and support over 
their lifetime and typically use less material and energy 
to produce.

More products per year: Engineers spend less 
time troubleshooting at the end of the product develop-
ment process, so they have more time to work on new 
products.

Increased innovation: With a new set of tools 
and skills, engineers can experiment with new designs 
and processes more often to create truly innovative 
products. 

What to Look For 
in Enterprise-Enabled 
Simulation Software

When looking for an enterprise-enabled simulation 
software product, consider the following key 
points:

Accessibility: Simulation must be easily accessible 
by any member of a design-to-manufacturing team. 
This means going from only a few users to many users 
and enabling even occasional users quick and easy ac-
cess to the simulation technology that will allow them to 
optimize their input to the design.

Configurability: The user interface and number of 
analysis options should be configurable based on job 
function, knowledge, skill, and experience. If someone 
is involved in industrial design or part production, the 
software should be customizable in such a way that 
makes it easy to learn and use with minimal training 
and support requirements, while still maintaining all the 
functionality the expert user requires.

Process integration: Enterprise-enabled simula-
tion software should integrate easily with existing ap-
plications, especially 3D CAD and CAE software, as well 
as proprietary, company-specific applications.

Communication focus: Valuable simulation re-
sults are only as good as your ability to communicate 
them to other members of a design-to-manufacturing 
team. The software should export to a number of in-
dustry standard formats, including Microsoft Word and 
PowerPoint and HTML-based web reports, as well as of-
fer free results viewing software so engineers outside 
the organization can have full access to the analysis re-
sults.

 

Strategic implementation: Enterprise-enabled 
simulation must come with a strategic implementation 
plan that covers everything from licensing to training, 
technical support, and material testing to maximize the 
return on investment and ensure simulation is incorpo-
rated into the best practices of the organization. 
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software provider for long-lasting, 
cooperative growth and success.

Using Simulation 
throughout 
Development

While it is important to utilize 
simulation as early as possible in 
development, such as the analysis 
of Microsoft’s keyboard during 
industrial design, it is also critical 
for design and tooling engineers to 
take advantage of simulation tools 
to optimize their work as well. 

Design Engineering

Many firms contracted to 
design plastic parts, especially 
for the automotive industry, view 
molding feasibility analysis as the 
responsibility of the mold shops, 
and therefore, simulation typically 
is not performed at a time when 
the part design could be optimized 
for molding. This has resulted 
in some automakers requiring 
simulation results to be included 
in the approval process for product 
designs while others are taking 
matters into their own hands.

Glenn Reed, Mechanical Technical 
Expert at Ford Motor Company, uses 
simulation to assist in overseeing 
the supplier development of CD/
DVD players and in providing them 
with technical support. He uses 
simulation as his “Expert Checker” 
to analyze incoming designs from 
his suppliers for anything from short 
shot conditions to the potential of 
sink and warpage. 

Reed’s viewpoint is that design-
ers and engineers are in the best 
position to impact the cost of the 
part and that true optimization re-

With the advent of Moldflow 
Plastics Insight Enterprise Edition™ 
(MPI-e™), Moldflow is leading the 
way for companies that want to 
implement enterprise-enabled sim- 
ulation to optimize their product 
development cycles. MPI-e is an 
enterprise-enabled simulation soft-
ware suite that comprises all of 
Moldflow’s core products:

 

The key features of MPI-e that 
enable it to perform as an enterprise-
enabled simulation solution include 
a task-based floating license 
system, customizable workspaces, 
multiple importing and exporting 
capabilities, and extensive reporting 
and communication tools.

MPI-e is based on tasks that 
float on a network, giving both 
occasional and dedicated users 
access to the full suite of simulation 
tools. The MPI-e Dashboard allows 
users to see the usage of licenses 
on the network and to reserve, 

check out, or check in tasks easily. 
The Dashboard also ensures that 
all licenses are used efficiently by 
providing users the information 
they need to determine which task 
level is required for the analysis 
they need to perform.

Customizable user workspaces 
included in MPI-e can expose the 
user to as much or as little of the 
functionality as required. Profiles 
can be created for novice users 
so they are guided through the 
analysis process to find typical 

problems specific to their job 
function. For more advanced users, 
more functionality and flexibility 
can be given to ensure they have 
the resources needed for their 
phase of the design process.

MPI-e integrates with existing 
design applications using robust 
CAD interfaces, making it quick and 
simple to import 3D solid geometry 
that is ready for analysis. MPI-e 
also includes interfaces that link  
Moldflow results to leading structural 
CAE applications to ensure that 
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structural analyses performed on 
injection molded plastic parts are 
of the highest possible accuracy. 
MPI-e also features an application 
programming interface (API) that 
can be used to customize outputs 
and interface with other software 
applications used across the 
organization.

The enterprise-wide implemen-
tation of MPI-e means everyone 
within the organization has access 
to open up the software to inter-
pret the results of an analysis. To 
communicate results outside the 
enterprise, MPI-e also includes 
advanced reporting tools that cre-
ate Microsoft Word, PowerPoint or 
internet-ready reports. MPI-e can 
also export results to the Moldflow 
Communicator, a free product that 
allows anyone to visualize, quan-
tify, and compare simulation re-
sults.

The Moldflow 
Advantage

When you purchase a Moldflow 
product, you are investing in a 
technology partnership founded on 
new product innovation and world-
class customer support and training. 
With close to 300 employees in 
15 different countries, Moldflow 
is a truly global company able to 
provide all our customers with local 
sales and technical services. Some 

of the additional services Moldflow 
offers include:

Material testing �  – 
Moldflow’s software currently 
contains the largest database 
of materials characterized for 
use in CAE with over 8000 
different resins available. If a 
particular material is not already 
in the database, Moldflow has 
two state-of-the-art labs, one 
in the US and one in Australia, 
that can fully characterize both 
commercial and proprietary 
grades of resins. Patented 
tests performed in Moldflow’s 
labs are specifically designed 
to ensure that analysis results 
accurately reflect what happens 
in real-world molding, so design 
changes can be made with 
confidence.  

Expert-led training �  – 
The key to maximizing the 
investment in simulation is 
to train users so they feel 
comfortable using the software 
and confident in their results. 
Moldflow offers a variety of 
training options including expert 
instructor-led courses that are 
available either on-site or in 
one of the Moldflow Center 
for Professional Development 
classrooms. Along with training, 
Moldflow also offers a formal 

program where users are 
evaluated on their level of 
simulation knowledge and are 
able to earn bronze, silver, and 
gold level certifications. 

Technical support �  – 
Moldflow's technical support 
engineers are highly trained in 
software usage and typically 
have extensive experience in 
the injection molding industry. 
Whether you are having issues 
with licensing or need help 
running a problematic analysis, 
the support engineers are there 
to help. And, with engineers in 
15 different countries, we are 
able to provide that support 
locally to make sure you are 
getting the best possible service.

Steve Papa, Applications En-
gineer at SABIC Innovative Plas-
tics, notes, “A competitor has been 
trying to get me to look at their 
software, supposedly as good and 
cheaper to purchase. A big reason 
I am not interested in looking at 
their product is because of Mold-
flow’s technical staff. They are tru-
ly the differentiators and are a big 
reason why I will always stick with 
Moldflow.”

To take the first steps towards optimizing your product development cycle using enterprise-enabled simulation, visit us at www.moldflow.com/enterprise.

quires design iterations that are 
improved through the use of simu-
lation. He proudly carries the torch 
and preaches to managers and en-
gineers around him to develop and 
share a “Simulation Attitude!” 

Mold Design

Mike McCullough, Process 
Engineer at OEM/Erie, a Tier 1 and 
2 supplier to General Motors and 
Chrysler, estimates that they see 
an average savings of $7500 on 
each mold by utilizing simulation 

during design. McCullough says, 
“The savings come as a result 
of decreased prototype time to 
get good parts, optimizing gate 
locations early in the process, 
accurately predicting cooling 
patterns, eliminating mold retooling 
and freight costs, and material 
savings due to fewer defects.”

Beyond this, OEM/Erie has 
used simulation to add a new 
competency to their portfolio: 
in-mold decorating (IMD). After 
taking on a project for International 
Truck and Engine Corporation for 

three interior consoles, simulation 
was used extensively to place the 
gates, design the runner systems, 
and optimize the cooling layout.

McCullough notes, “Overall, 
[simulation] predicted the thermal 
effects of the in-mold decoration 
material quite well. Simulation 
is critical for successful IMD as 
the gating, filling and process 
conditions can make or break your 
quality.” ■
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C ompanies like Arling-
ton, Vermont-based Mack 
Molding Company are 

using 3D process simulation to  
realize more fully the advantages 
inherent in the gas-assist process 
to produce the high-quality parts 
efficiently and economically. 

Gas-assisted injection molding 
is a versatile process that 
provides tremendous flexibility 
in the design and manufacture 
of plastic parts. Compared to 
conventional injection molding, 
the gas-assisted process has the 
potential to produce hollow, light-
weight, rigid parts that are free of 
sink marks and less likely to warp. 
Additional advantages include 
material savings, reduced cycle 
time, reduced pressure and clamp 
force tonnage requirements, and 
the ability to consolidate thick and 
thin sections in a single part.

Because the process involves 
the dynamic interaction of two 
dissimilar materials flowing within 
typically complex cavities, opti-
mizing product, tool and process 
design for gas-assisted injection 
molding can be quite complicat-
ed. Furthermore, experience with 
conventional injection molding  
is not sufficient to address the 
specialized requirements of the  
gas-assisted process, especially  
in designing the gas-channel net-

work, optimizing gas penetration 
and optimizing the processing 
window.

Process Overview
The gas-assisted injection 

molding process begins with 
a partial or full injection of 
polymer melt into the mold 
cavity. Compressed gas (typically 
nitrogen) is then injected under 
pressure control or volume 
control into the core of the 
polymer melt to help fill and 
pack the mold. Gas may be 
injected either through the nozzle  
of the molding machine, or by 
direct injection into the mold or 
into a runner. 

Short-shot vs. Full-
shot Techniques

In the short-shot gas-assist 
process, the cavity is partially 
filled with plastic before gas 
is injected to complete cavity 
filling by pushing the plastic into 
the unfilled areas of the part. 
Maintaining gas pressure after the 
cavity is filled helps to pack the 
plastic and compensate for plastic 
shrinkage.  

In the full-shot gas-assist 
process, gas injection starts only 
after the cavity is completely 

filled with plastic.  A variant of the 
full shot process incorporates an 
overflow well (or overspill) at the 
end of a gas channel. An overflow 
well is a secondary cavity, typically 
controlled by a valve gate, into 
which the gas can displace 
polymer and thereby penetrate 
further into the part. The gas 
packs the cavity by penetrating 
into the regions where the plastic 
is shrinking, and the extent of gas 
penetration is directly influenced 
by the shrinkage characteristics 
of the material. 

real world success

For companies involved with gas-assisted 
injection molding, Moldflow’s MPI/Gas 
simulation software provides know-how 
needed to understand this complex process 
and ensure that part designs, mold designs 
and the molding process itself are optimized 
before production or even tooling begins.                                               

3D Gas-Assisted Injection Molding 
Simulation Streamlines Concept-to-Production

By MaRcia Swan, editoR

Stages and sequence of the gas-assisted 
injection molding process.2

Mack Molding Company evaluated MPI/3D Gas simulation during the development of this new mass transit seat design.1
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Typical Applications

Typical applications for the gas-
assisted process can be classified 
into three categories: 

Tube- or rod-like parts � , 
where the process is used 
primarily for saving material, 
reducing the cycle time and 
incorporating product function 
into the hollowed section(s) . 

Large, sheet-like,  �

structural parts with a built-
in gas-channel network, where 
the process is used primarily 
for reducing part warpage and 
clamp tonnage requirement, as 
well as to enhance rigidity and 
surface quality. 

Complex parts �  comprising 
thin and thick sections, where 
the process is used primarily 
for decreasing manufacturing 
cost by consolidating several 
assembled parts into a single 
part design. 

Moldflow Solutions for 
Gas-assist Applications

MPI/Gas software allows users 
to study polymer and gas flow 
behavior within a part model and 
examine the influence of design 
and process modifications on the 
polymer/gas system.  Simulation 
results provide information to 
optimize product design, including 
gas channel layout and size; 
position polymer and gas injection 
points; and detect and avoid 
common problems such as gas 
permeation or fingering, gas blow-
through, poor gas penetration and 
short shot. 

The latest release of MPI/Gas 
software extends 3D analysis ca-
pabilities to simulate part warpage. 
Now part designers, mold design-
ers and process engineers can use 
simulation results to:

Aid in material selection,  �

including materials with fibers or 
fillers.

Optimize part design  �

including gas channel networks 
to promote desired gas 
penetration.

Evaluate mold design options  �

including gas entrance options 
and their impact on gas 
penetration.

Determine appropriate process  �

conditions to achieve successful 
molded parts.

Predict effects of gas channels  �

on the post-molding shrinkage 
and warpage of the final part.

Quantify benefits of the gas- �

assist process compared to 
conventional injection molding.

Customer Analysis 
Using MPI/3D Gas 
Simulation

Mack Molding Company is a 
leading custom plastics molder and 
supplier of contract manufacturing 
services. The company operates 
six injection molding facilities in 
the eastern United States, with 
120 injection molding machines 
ranging from 28 to 4000 tons 
of clamp force, shot sizes from 
0.6 to 800 ounces, and expertise 
in specialty molding processes, 
including solid injection, structural 
foam, overmolding, internal and 
external gas-assist, and two-shot 
molding.

Dr. Michael Hansen is a Senior 
Technical Development Engineer at 
the company’s Arlington, Vermont 
headquarters plant. Hansen is a 
proponent of molding simulation 
and supports incorporating the 
technology into everyday workflow. 

“Using molding simulation allows 
us to test and verify key aspects 
of a new product design during 
development. Results help us 
to confirm material selection, 
streamline part and mold design 
and verify processing parameters, 
even for our most challenging 
applications,” he notes.

Hansen has been working in 
conjunction with BASF, the world’s 
leading chemical company, to 
evaluate 3D simulation capabilities. 
Here, he presents an analysis that 
illustrates the utility of the MPI/3D 
Gas software for an innovative 
gas-assisted injection molding 
application.

 Mass transit seat
For a new seat design for 

mass transit vehicles, the gas-
assist process using a reinforced 
composite resin was chosen to 
meet requirements of efficient 
use of material, aesthetics, and 
product structural performance 
criteria. Tooling considerations 
included filling the part from a 
single, central location on the part 
to avoid knit lines and placing gas 
pins and overflow wells in locations 
that would not be visible when the 
finished product was installed. 

Using MPI, Hansen was able to 
import the 3D CAD model directly, 
eliminating the need to prepare 
a special model for molding 
simulation. Hansen used MPI/3D 
Gas simulation to investigate gas 
penetration patterns, gate and gas 
pin locations, overflow well location 
and size, as well as processing 
parameters including gas delay 
time, gas pressure, plastic fill time 
and clamp force, among others.

Molding trials showed good 
agreement with simulation results. 

For this application, optimizing 
part and tool design, material 
selection and choice of molding 

real world success

Using molding simulation 
allows us to test and verify 
key aspects of a new product 
design during development.

MPI/Gas Capabilities

Analysis Type Analysis Technology

Fill

Fill+Pack

Fiber Fill+Pack

Cool 

Warp

Stress

Midplane Model              3D Model
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technique were essential to 
assuring manufacturability and 
durability of the finished product. 
Hansen emphasizes, “Using CAE 
tools is a key factor in time-to-
market and achieving  a smoother 
transition from concept to real-life 
production.” ■
Mack Molding Company provides design 
through FDA-approved manufacturing ser-
vices to the medical, commercial, computer 
and business equipment and transportation 
markets. With 87 years of plastics expertise, 
the company integrates product develop-
ment, custom injection molding, sheet metal 
fabrication, and full product assembly in ISO 
9001 and ISO 13485 environments. Product 
development resources include design, pro-
totyping and extensive engineering services.

Molded short shots (shown in blue at left in each pair of images) produced at intervals 
throughout the cycle corresponded closely to the predicted plastic filling pattern at the 
same times (rendered in green at right in each pair of images).3

Cross-sections cut through gas channels showed that the gas penetration in the 
molded parts (at top in each pair of images) also corresponded closely to the 
predicted gas penetration (at bottom in each pair of images).4

MPI/3D Gas simulation results helped to confirm the design of the gas channel pattern.5

Images provided courtesy of Mack Molding Company: 
 
1, 3, 4, 5 Michael Hansen, Ph.D., Mack Molding Co., “Gas-assisted Mass Transit Seat: Comparing Real-life Molded Part Data with Simulated 3D Numeric Mold Filling 
Results,” Society of Plastics Industry Conference, Memphis, TN, April 2007. 
 
2 Michael Hansen, Ph.D., Mack Molding Co., “Gas-assist Injection Molding: An Innovative Medical Technology,” MD&DI, August 2005.  
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In addition to preparing reports in the default 
HTML format, users can also produce reports in 
Microsoft® Word® document (*.doc) and Power-

Point® presentation (*.ppt) formats. Extensive docu-
mentation and examples of how to create reports can 
be found in the MPI and MPA product Help systems 
(Help > Search Help > Contents (tab) > Working 
with Reports or Help > Tutorials > Generating 
Reports).

This article presents three useful tips related to 
report generation, including how to use the Plot Note 
tool, how to save images with multiple results or 
studies, and how to avoid report viewing errors when 
saving reports with embedded animations in *.doc or 
*.ppt formats.

 Tip 1: Add a Plot Note to a Result
The Plot Note tool offers a useful way to add text 

comments that are associated with a particular result 
plot, and the notes are saved with the study. When a 
result image with an associated plot note is added to 
a report, the text of that plot note is used as the initial 
image description in the report. Any changes made to 
this text once it has been included in the report will 
only appear in the report; the text of the plot note 
itself remains unchanged. 

This feature is particularly useful when generating 
many reports that use similar text or when including 
long, explanatory descriptions. The procedure to add 
a plot note to a result in an open study is as follows:

➊ Display a result plot.
NOTE: This feature is available only for analyses that produce at 
least one graphical result plot.

➋ Click         (Results > Plot Notes). 

The Plot Notes tab of the Notes panel appears and 
becomes active.

➌ Enter the text to associate with the displayed result  
 plot in the space provided.

➍ Click       (File > Save Study) to ensure that the 
 note text is retained with the result in the study.

NOTE: Each plot note is associated with a single result plot.

For our example cell phone cover part (Figure 1), we 
have already successfully completed a Dual Domain Fill 
analysis using MPA 8.1 software. Figure 1 shows the 
results of adding plot notes to a Pressure at end of 
fill result.  

 Tip 2: Capture Split Windows or  
       Multiple Studies in One Image

When discussing multiple results of one study or 
comparing results of more than one study in a project 
report, it is often useful to view a single image that 
presents all of the results or studies simultaneously 
instead of having to scroll through separate report 
images that may span several pages. The Image 
Capture Option feature specifies the portion of the 
Graphics Display Area that is captured when copying 
an image to the clipboard or saving an image to a file. 
The options are:

Active View �  causes the active view in a split  
  window, or the window of the active study if it  
  contains only one view, to be captured. 

All Views �  causes all (up to four) views in a split  
  window of the active study to be captured. 

Graphics Display Area �  causes all of the  
  windows displayed in the Graphics Display Area,  
  including the Analysis Log/Results Summary 
  pane if you  chose to display it, to be captured.

When the captured image is saved to a file, it must be 
added manually to a project report.

Moldflow Plastics Insight® (MPI®) and 
Moldflow Plastics Advisers® (MPA®) products 
both offer an easy-to-use Report Generation 
Wizard that helps users to summarize and 
communicate analysis results with others.                          

tips & techniques

Tips to Facilitate 
Report Generation  

By MattHew JawoRSki, tRaining SeRviceS ManageR



www.flowfront.com 29Flowfront | May 2008

tips & techniques

To capture four results of one study in a single 
image, follow this procedure:

➊ Open a study that includes results.

➋ Use the     Horizontal Split and     Vertical Split tools  
 on the Viewer toolbar (View > Toolbars >Viewer) to 
 create four views in the active study window.

➌ Select View > Lock > All Views. 

 This synchronizes the rotation, panning and zooming of  
 all views in the split window.

➍ Use the         Rotate tool on the Viewer toolbar to rotate  
 the model to an appropriate viewing angle.

➎ Display a different result in each view.

➏ Select Edit > Image Capture Option > All Views to  
 capture all four split views in the active study window  
 (see Figure 2). 

➐ Select Edit > Save Image to File.

➑ Navigate to the location in which you want to save the  
 image file.

➒ In the File name text box, enter a name for the image  
 file.

➓ Select the desired image file format from the Save as  
 type drop-down list, and then click Save. 

To capture results of multiple studies in a single 
image, follow this procedure:

➊ Open at least two studies that include results.

➋ Use the Window > Tile Horizontally or Tile Vertically  
 tools to make all of the study windows visible in the  
 display.

➌ Display the result(s) of interest in each study.

➍ Select Edit > Image Capture Option > Graphics Display  
 Area to capture all windows displayed (see Figure 3). 

➎ Select Edit > Save Image to File.

➏ Navigate to the location in which you want to save the  
 image file.

➐ In the File name text box, enter a name for the image  
 file.

➑ Select the desired image file format from the Save as  
 type drop-down list, and then click Save.

  

Figure 2: Example of a single captured image showing multiple 
results from one study in split views.

Figure 3: Example of a single captured image showing results 
from two studies in windows that have been tiled vertically.

Figure 1: Plot note added to Pressure at end of fill result in 
MPA 8.1.
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 Tip 3: Set File Type Association to     
       View Report Animations Properly

When generating project reports in *.doc or *.ppt 
formats, two preliminary steps are necessary.

 1. The appropriate Microsoft program must be installed 
on the computer on which the report is generated. 
Reports can be viewed using the appropriate Word or 
PowerPoint program in the Microsoft Office 97 suite or 
later versions.

 2. All Windows systems must have required file type 
association settings in order for the reports to display 
embedded images and animations properly. 

To display embedded animations in *.avi format 
in *.doc or *.ppt reports, the *.avi animation file 
type should be associated with the default Microsoft 
Windows Media Player. If the *.avi file type is associated 
with another program, embedded animations may not 
display properly when the generated report is view 
using the Microsoft Word or PowerPoint program.

To check and change *.avi file type association 
setting, follow this procedure:
NOTE: It is recommended that you close all programs before 
proceeding.

➊ From the Windows Start menu, select Control  
 Panel. 

➋ On Windows XP systems: 

 a. From the Name list, select Folder Options. The 
  Folder Options dialog opens. 

 b. Select the File Types tab.

 c. Scroll through the Registered file types list and 
  find AVI in the Extensions list. The Details for 'AVI'  
  extension area should show that files with  
  extension *.avi open with Windows Media Player. 

 d. If another program is associated with the *.avi  
  extension, click the Change button. The Open With  
  dialog appears. 

 e. Select Windows Media Player from the Programs  
  list. Ensure that the Always use the selected  
  program to open this kind of file option is turned  
  on. Click OK to accept the selection and return to  
  the Folder Options dialog. 

 On Windows Vista systems:

 a. From the Name list, select Default Programs.  
  The Default Progams dialog opens. 

 b. Select Associate a file type or protocol with a  
  program. The Set Associations dialog opens.

 c. Scroll through the Extensions list and find the  
  *.avi extension. The Current Default column should  
  show that files with extension *.avi open with 
  Windows Media Player. 

  
 d. If another program is associated with the *.avi 
  extension, click the Change program button. The  
  Open With dialog appears. 

 e. Select Windows Media Player from the  
  Recommended programs list. Ensure that the  
  Always use the selected program to open this  
  kind of file option is turned on. Click OK to accept  
  the selection and return to the Set Associations  
  dialog. 

 ➌ When the *.avi file type is set to open with Windows 
  Media Player, click Close to accept these settings. 

 ➍ Close the Control Panel.

NOTE: Changing the file type associations as described restores 
Windows default behavior and file type associations, which other 
graphic programs might have overridden. Changing these file 
type association settings should not cause problems when using 
any other programs. ■

tips & techniques

Learn more Tips & Techniques  ❙  Visit the MPI Community Center or MPA Community Center today. Registered customers will find Hints and 
Tips articles, user discussion forums, known bugs and limitations, and a host of other valuable information.
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There is a saying that “knowledge itself is not fully realized unless it is shared.” The 
knowledge gained from performing CAE analysis is no exception to this statement. One 
of the best ways to communicate analysis results to others is to share the actual results 
themselves.                                       

Automating the Creation of 
Results Files Using the  
Moldflow Plastics Insight API  

By MattHew JawoRSki, tRaining SeRviceS ManageR

Moldflow Plastics Insight® 
(MPI®) and now Moldflow 
Plastics Advisers® (MPA®) 

users can export Moldflow Results 
files (*.mfr) for use with Moldflow 
Communicator. Moldflow Commu-
nicator is a free utility developed 
specifically for visualizing, quanti-
fying and comparing Moldflow Re-

sults files; download it from www.
moldflow.com/communicator. 

Moldflow results files can 
contain a specified number of 
results from one or two studies in 
a project, thus allowing users and 
non-users alike to share analysis 
results and design knowledge 
within distributed product teams 
and across organizations. However, 

the manual process of marking 
results for export can be tedious, 
especially if more than one study is 
involved. This article shows you how 
to automate the creation of *.mfr 
files in MPI using the Application 
Programming Interface (API), 
which is an Object Linking and 
Embedding (OLE) programming 
interface.

 
 
Objective:  
Automate MPI *.mfr file 
creation for any study with 
Dual Domain Fill+Pack 
analysis results. 

 
Step 1: Preparation

For our example lid part (Figure 
1), we have already successfully 
completed a Dual Domain Fill+Pack 
analysis and customized any 
plot properties by right-clicking 
on a desired plot and selecting 
Properties. Figure 1 shows the 
results of changing the Fill time plot 
properties to display as contour 
lines. 

 
 

Figure 1: Fill time plot with properties modified to display contour lines.

tips & techniques
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Step 2: Recording a Macro
You do not have to be a guru in computer 

programming to use the API functionality effectively. 
The easiest way to get started is to record the steps 
you want to automate using the macro recording tool 
in MPI’s user interface, Synergy. The procedure to 
record a macro for marking and exporting results to 
an MPI *.mfr file is as follows:

➊ Click          (Tools > Start Macro Recording).

➋ Right-click on a result name in the list of results 
 and select Mark for export. 

 An asterisk appears after the result name indicating  
 it has now been marked for export. 

 NOTE: Analysis logs are exported by default. To exclude all  
 analysis logs from the Moldflow Results File, right-click the Logs  
 checkbox, then select Unmark for export. 

➌ Repeat to mark additional results for export in the  
 same way.

 In this example, we have marked six results  
 for export: Fill time, Pressure at V/P switchover,  
 Volumetric shrinkage at ejection, Average velocity,  
 Bulk temperature, and Temperature at flow front  
 (see Figure 2).

 NOTE: MPI 6.2 and MPA 8.1 allow you to export a maximum 
 of eight results per solver type from each study. 

➍ Click          (File > Export). 

➎ Navigate to the location in which you want to save  
 the export file. 

➏ In the File name text box, enter a name for the  
 export file. 

 In this example, our file name is fill.mfr.

➐ Select Moldflow Results File (*.mfr) in the Save  
 as type drop-down list, and then click Save. 

➑ A confirmation dialog appears to inform you the  
 results were exported successfully. Click OK.

➒ Click          (Tools > Stop Macro Recording).  
 The Save Macro dialog appears.

➓ Navigate to a directory of your choice, enter a  
 name for the macro in the File name box, and  
 then click Save.

 The new script is saved with a *.vbs file extension,  
 and it now can be used as a Visual Basic script.  
 In this example, our script name is mfr_export. 
 vbs, and it is saved in the directory C:\My MPI  
 Projects\scripts.

NOTE: The default script location depends on the operating system 
and installation parameters, but you can modify the location by 
changing your preferences within Synergy (File > Preferences > 
General (tab) > Project directory).

Table 1 shows the contents of the recorded macro. NOTE: The numbers 
listed before the script lines in Table 1 are there for reference only.

Line 1 ensures the locale in which the script was   ➠
  recorded, in this case English – US, is also the  
  locale in which the script is played back to avoid  
  any locale-related character issues.

Line 2 creates an OLE automation object that   ➠
  starts the most recent version of Synergy. 

NOTE: Only one version of Synergy is able to run at any time 
when using the API. 

Line 3 defines the default units. English   ➠
  can replace Metric in this line to use English  
  measurement units by default.

Lines 4, 6, 8, 10, 12, and 14 initialize the   ➠
  PlotManager object using the Synergy  
  PlotManager class. Only one statement is  
  needed, but the recorded script treats each user  
  interface action as a discrete action, thus  
  resulting in the redundancy. 

Lines 5, 7, 9, 11, 13, and 15 mark our selected   ➠
  results for export using the PlotManager class.

NOTE: The MarkResultForExport function is sensitive to result 
name changes, so this script may not be compatible with future 
or previous MPI releases if the result names are different.

Line 16 initializes the Project object using the   ➠
  Synergy Project class.

Line 17 exports the *.mfr file to the path   ➠
  specified using the Project class. The True text  
  is for the dialog box decisions associated with  
  this export command. 

Table 1: Macro Recording:

SetLocale("en-us")1. 

Set Synergy = CreateObject("synergy.Synergy")2. 

Synergy.SetUnits "Metric"3. 

Set PlotManager = Synergy.PlotManager()4. 

PlotManager.MarkResultForExport "Fill time", True5. 

Set PlotManager = Synergy.PlotManager()6. 

PlotManager.MarkResultForExport "Pressure at V/P  7. 
 switchover", True

Set PlotManager = Synergy.PlotManager()8. 

PlotManager.MarkResultForExport " Volumetric  9. 
 shrinkage at ejection", True

Set PlotManager = Synergy.PlotManager()10. 

PlotManager.Mark Result ForExport "Average  11. 
  Velocity", True

Set PlotManager = Synergy.PlotManager()12. 

PlotManager.MarkResultForExport "Bulk  13. 
  Temperature", True

Set PlotManager = Synergy.PlotManager()14. 

PlotManager.MarkResultForExport "Temperature at  15. 
  flow front", True

Set Project = Synergy.Project()16. 

Project.Export "C:\Temp\mfr_Export\fill.mfr", True,  17. 
  True
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Figure 2: Results marked for export are indicated by an asterisk after 
the result name in the Study Tasks pane. 
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Step 3: Using a Saved Macro  

Now we can use the saved macro script to export 
the selected results automatically from any Dual 
Domain analysis that has Fill+Pack results, without 
having to mark each result for export manually. The 
procedure for playing a saved macro is as follows:

➊ Select         (Tools > Play Macro). The Open Macro 
dialog appears. 

 Navigate to the location where the desired macro  
 file is stored. In this example, our macro file was  
 saved in the C:\My MPI Projects\scripts 
 folder.

NOTE: The default macro location is system and install 
dependent. 

➋ Select a script, then select Open. In this example, we 
open the mfr_export.vbs file.

➌ The script plays.

NOTE: You must use the MPI command line if the script requires 
command line arguments, unless the script prompts for user 
input. 

Step 4: Modifying the Macro Script 
We could easily stop here, but what if we want to 

make modifications to further enhance the automation 
or usability of the script? Below are some examples 
of enhancements that could be added to improve 
the script, such as adding explanatory comments, 
checking for errors, and adding a pop-up window to 
allow user-specified file name changes during export.

Lines beginning with  ➠ the single quote character  
  (‘) are comment lines and are ignored when  
  the script is executed. It is generally considered  
  good practice to add explanatory comments at  
  the beginning of scripts for future reference. 

Lines 1-18 ➠  use the ‘@ prefix to signify help text  
  for a command. Line 19 uses the ‘@@ prefix to  
  signify the end of the help lines. If the script file  
  (mfr_export.vbs) is placed in the MPI  
  installation  commands directory, typing "help  
  mfr_export" in the Synergy command line  
  will extract the help header information and  
  display it as command help, as shown in Figure 3.

Line 20 ➠  forces explicit declaration of all variables  
  in that script (e.g. Dim in lines 20-21), which  helps  
  reduce programming errors. For instance, if you  
  attempt to use an undeclared object name, an error  
  occurs.

Lines 21-22 ➠  declare object variables and allocate  
  storage space.

Example Modified Script Segments 
to Automate MFR File Creation: Help, 
Comments and Explicit Option

'@ DESCRIPTION1. 

'@ This command will automatically export specified MPI 2. 
Dual Domain

'@ Fill plots into an MFR file for one study.3. 

'@   4. 

'@ Plots are Fill time, Pressure at V/P switchover, 5. 
Volumetric shrinkage

'@ at ejection, Average velocity, Bulk temperature, 6. 
Temperature at flow

'@ front7. 

‘@8. 

'@ SYNTAX9. 

'@ mfr_export10. 

'@11. 

'@ DEPENDENCIES/LIMITATIONS12. 

'@  1. User must open a study in MPI Synergy before 13. 
using this command

'@  2. The study must have fill analysis results for a Dual 14. 
Domain mesh

‘@  3. Script valid for MPI 6.x result plot names 15. 

'@16. 

'@ HISTORY17. 

'@ Created by MJJ; 14/Mar/0818. 

‘@@ 19. 

Option Explicit20. 

Dim CustomText, FileName, Fpath1, Fullpath, 21. 
FullPathMsg, FullPathTitle

Dim fso, Plot, PlotManager, Project, StudyDoc, Synergy22. 
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Line 23 ➠  initializes the Plot object with the Fill time  
  result. Any available result plot name can replace  
  the Fill time text to change the result retrieved.  
  This is useful to know if you want a different set of  
  results exported than those used in this example, or  
  if the result name changes in a future MPI release.

Line 24-27 ➠  is an If statement that checks if a Fill  
  time result exists in the study. If it does not,  
  Nothing is returned and a message box titled  
  ERROR pops up and displays the message text  
  shown in line 25.

Line 26 ➠  quits the script.

Line 28 ➠  initializes the Project object with the most  
  recent Synergy project.

Line 29 ➠  populates the CustomText object with user  
  input generated from a pop-up input box with  
  guided instructions.

Alternatively we could have used this line to obtain the user 
specified full path location and *.mfr file name for saving (e.g. 
C:\Temp\MFR_Export\fill.mfr). 

Line 30 ➠  initializes the fso file system object.

Line 31 ➠  uses the fso object to obtain the current  
  MPI project directory the active study is in.

Line 32 ➠  populates the Fullpath object with an  
  assembly of the project directory and user entered  
  export file name (e.g. CustomText object contents).

Line 33 ➠  exports the selected results to the user  
  defined mfr file in the current project directory.

Line 34 ➠  populates the FullPathMsg object with a  
  message indicating where the file was stored.

o Vbcrlf is a Visual Basic Carriage Return Line Feed which 
simply moves to the next line.

Line 35 ➠  populates the FullPathTitle object with text.

Line 36 ➠  uses the MsgBox function to display a  
  message box with the text in line 34 and the title  
  text from line 35. 

 

Step 5: Test-drive a Script 
A fully functional version of the modified script 

described in this article is available to registered MPI 
customers on the MPI Community Center web site in 
the Training Material > Macro Exchange - Scripts 
area; select Export MFR fill results to a file. 
Download this script onto your local computer and use 
Step 3 to try it out for yourself. 

NOTE: Moldflow Results files exported from MPI 6.2 
must be viewed with Moldflow Communicator 2.0.

Extensive documentation and more examples of 
using the API can be found in the MPI Help (Help 
> Search Help > Contents (tab) > Application 
Programming Interface (API) or Help > Tutorials 
> Automating MPI. ■

 
 

Figure 3: Command line help example

Results Availability Check

Set Plot = PlotManager.FindPlotByName("Fill time")23. 

If Plot Is Nothing Then24. 

MsgBox "No Fill time plot in result set",, "ERROR"25. 

WScript.Quit26. 

End If27. 

Change Export File Name 

Set Project = Synergy.Project()28. 

CustomText = InputBox("Enter the file name  29. 
  for the exported MFR file without an  
  extension:” & vbcrlf & “EX: fill.mfr", "Export  
  MFR File Name")

Set fso = CreateObject("Scripting. 30. 
 FileSystemObject")

Fpath1 = fso.GetAbsolutePathName(".")31. 

Fullpath = Fpath1 & "\" & Customtext32. 

Project.Export Fullpath, True, True33. 

FullPathMsg = "The MFR file was successfully  34. 
 saved in:" & vbcrlf & Fullpath

FullPathTitle = "MFR Export Successful!"35. 

MsgBox FullPathMsg,,FullPathTitle36. 

Learn more Tips & Techniques  ❙  Visit the MPI Community Center or MPA Community Center today. Registered customers will find Hints and 
Tips articles, user discussion forums, known bugs and limitations, and a host of other valuable information.
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T he products we develop must satisfy a variety 
of criteria, be aesthetically pleasing, functional 
over the product’s service life, safe, economical 

and they must be manufacturable.  Historically, plas-
tics products, like many other products, have been 
developed using the so called “Over the Wall Approach 
to Design”.  In many ways, it is human nature that 
the designers of new products want their own ideas 
to drive the development.  In reality however, this ap-
proach to product development does not lead to the 
most efficient product designs, at least not in a timely 
manner.  This series and compartmentalized approach 
to design, where there is limited communications be-
tween the various professionals involved in the de-
velopment process, is common.  Those involved in 
the early upstream concept stages of design, such as 
industrial design, establish the shapes that the engi-
neers, tooling designers and manufacturing engineers 
must bring to fruition.  In many cases, the part ge-
ometries established by the industrial designers and 
the product designers are in fact found to be difficult 
or impossible to manufacture once these proposed 
part designs reach the eyes of the tooling designer.  
In such a case, the tooling designer will recommend 
changes and a more manufacturing friendly design 
can be jointly developed.  However, it should be noted 
that the x-axis in figure 1 is time, and movement to 
the left along the x-axis is wasted time.  Delays in 
new product development are almost always traced 
back to a lack of coordination between various parties 
involved in the product development process.

The solution to this all too common problem is not 
complicated.  It is simply a matter of management 
philosophy.  The same product development groups 
shown in figure 1 must function more like a team 
with greatly improved communications.  Conceptually, 
“Concurrent Engineering” as it is commonly called, 
is like putting all of the professionals involved in the 
product development process in one room, with no 
walls between them.  When the industrial designer 

or the product designer propose a geometry, the 
manufacturing engineer or the tooling designer can 
weigh in immediately and bring manufacturing issues 
to the forefront before detailed designs are developed.  
This improved communications leads to more well-
balanced product designs that are achieved in a much 
more timely manner.  There are no surprises as the 
product develops because everyone involved in the 
product development process has had input into the 
key design decisions.

While the concept of concurrent engineering is well 
understood, it is not easily implemented in practice, 
largely for one very understandable reason.  Looking 
back many years, there were days when very large 
corporations did in fact employ all of the professions 
involved in new product development. Some companies 
did employ designers, mold makers, tool builders, and 
did molding/manufacturing in house.  In such a case, 
it would be relatively easy to literally put everyone 
involved in the same room.  Such a business model is 
rare today.  The reality today is that for the most part, 
corporations run lean.  The use of vendors for each of 
these product development functions is the norm, for 
good or bad.  The advantages of vendor-based product 
development are numerous in terms of economics and 
product quality when managed effectively.  Vendors 
that possess capabilities closely matched to the new 
product can be utilized.  However, from a concurrent 
engineering perspective, the logistics of bringing 
all of these people together, in the same room, so 
to speak, becomes an issue.  In some ways, it is 

Developing new plastic products is always an 
interesting challenge that can be approached 
in a variety of different ways. 

Taking Concurrent Engineering  
One Step Further: Consider Recycling

By RoBeRt Malloy, PRofeSSoR, univeRSity of MaSSacHuSettS lowell

perspective
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 Are you Moldflow Certified?
 
Moldflow certification is the global industry standard for profi-
ciency in the use of Moldflow Plastics Insight (MPI) software. 
Analysts can progress through three levels of individual certifi-
cation–Bronze, Silver and Gold. Company-level certification is 
also available. 

For more information about Moldflow certification and training services, 

contact Matthew Jaworski, Training Services Manager: 

E-mail:  training@moldflow.com     Tel: +1 814.460.5097

Why Become Certified?

Promote your organization as more  ➠ proficient than 
  your competitors

Earn more respect from colleagues and managers ➠

Realize potential for advancement opportunities ➠

Further your technical expertise as an analyst ➠

Make the most out of your software investment ➠
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actually much easier to be in the same “virtual 
room” today thanks to the wonders of internet-based 
communications.  However, this can only happen when 
project managers make sure this does happen.  The 
single most important action is to identify all vendors 
involved in the project up front and ensure that the 
lines of communication are well established.  The 
practice of designing products and then going out for 
tool bids is the ultimate example of the over the wall 
approach to new product development.  If concurrent 
engineering is to be practiced, designers, by definition, 
must have the ability to run their ideas past tooling 
and manufacturing groups before their designs are 
finalized.

The concurrent engineering and design concepts 
described above are well known and well established.  
But perhaps we need to take this concept of concurrent 
engineering one step further in terms of designing 
new products in a more environmentally friendly 
manner.  The products we design today, with very 
few exceptions, have been designed with little or no 
input from anyone who needs to deal with the product 
after it is used by the consumer.  The plastic products 
we design and manufacture today will all have some 
impact on our environment after their useful service 
life has expired.  Landfilling, incineration, composting 
(in the case of biodegradable or compostable plastics), 
reuse and recycling are all possibilities.  Recycling in 
some way, shape, or form, is clearly an admirable goal 
for any new product.  If we design and develop new 
plastics products without consulting the “recycler”, we 
are guilty of practicing the over-the-wall approach to 
design as it relates to the environment.  The design 
of a product has a very significant impact on the 
recyclability of the product.  It is important to note 
that designers do not determine if a product will in fact 
be recycled, but designers do have a direct impact on 
the “ease” of recycling a product, which does impact 
the likelihood of recycling.

Like concurrent engineering itself, this 
environmental design concept is simple; bring the 
recycler into the room when new products are 
developed, so that they can provide their insight 
when important design decisions are made.  As with 
any input, the project leader may choose to take or 
ignore the advice, but at least an informed decision 
can be made with respect to potential recyclability.  
The primary objective of the product designer is to 
design a functional product economically, but if the 
product can also be more easily recycled, that is a 
plus.  Even very simple design changes can have a 
very significant impact on the recyclability of a product.  
Materials of construction, ease of disassembly, coding, 
methods of decorating are but a few of the important 
areas of concern.  Replacing screws and inserts on an 
electronics enclosure with snap fits would make the 
enclosure more recyclable.  The recyclability should 
not be the sole factor in driving the design but should 
be taken into consideration as a factor.  Likewise, if 

several materials were being considered for a new 
plastics part, and one was more recyclable than the 
others, that should be considered along with other 
material properties being considered.  

The concept of involving the recycler when making 
major design decisions is simple, but the practice of 
doing so is not as easily implemented in most cases 
for one simple reason.  The “recycler” is not always 
easily identified.  In a limited number of cases, where 
the plastics recycling infrastructure is well established, 
it is a reasonable expectation to include the recycler 
as part of the product development team because 
the recycler is easily identified.  Designers of HDPE 
bottles can look to trade associations and commercial 
recyclers for guidance without difficulty.  However, the 
limited plastics recycling infrastructure means that 
designers of most plastic products, even designers who 
have the desire to consider the recyclers input, may 
not have the option to do so.  As we move forward in 
time, the plastics recycling infrastructure will continue 
to develop, and the simple concept of involving the 
recycler in the early stages of product development 
will hopefully become more of a widespread reality. ■
Currently serving as the Department Chair at the University of 
Massachusetts Lowell, Prof. Malloy remains an active educator and 
researcher in the areas of plastics product design, polymer processing, 
recycling of thermoplastics.  UML now offers on-line graduate classes 
in plastics. Go to http://plastics.uml.edu.
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If your company is using a unique 
approach to design or manufacture 
injection-molded parts, we’d like 
hear about it, and potentially 
inform our readers. 

There may also be potential to have 
an article on our web site, or have you 
speak at our next user group meeting.  
 
For more information, please contact:

Case Studies 
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Brian Sather
+1 508.358.5848, x289

brian_sather@moldflow.com

For advertising information, please contact Melissa Aytek:
Tel: +1 508-358-5848 x258, E-mail: melissa_aytek@moldflow.com 
www.flowfront.com, click Advertise. 
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